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B 

Exercise Introduction 

1. Exercise Aim and Plan 

This exercise’s aim is to become acquainted with dynamic properties of the VDMOS power 
MOSFET transistor and its resulting applications. 

In the first part of the exercise, transistor’s operation in the dynamic states—turn-on and turn-
off—will be investigated. The effect of the control circuit on time parameters describing transistor 
switching will be observed. Next, the relationship between switching process duration and power 
loss will be analysed. This will enable understanding one of the reasons for which engineers tend to 
obtain the highest possible switching speed of power semiconductor devices. 
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2. VDMOS Switching 

2.1. Recommended reading 

Ref. Textbook Excerpt 
Equivalent in the 

Polish Manual 
Complementary 

Reading 
Complements 
in this Manual 

A Ben 10, 10.1, 10.1.1, 
10.1.2, 10.2, 10.2.1 

2.1, 2.2, 3.2; Ref. [1] [13] 4, 6 3)  

B Ben 10.2.2 incl. Fig. 10.6 2.3, 2.4.e [13] 6 1)  

C Ben 10.3, 10.3.1, 10.3.2 2.4, 2.5.a   

   2.5.b  2.2 

Additionally, from Manual 0 references: 

Ref. Textbook Excerpt 
Equivalent in the 

Polish Manual 
Complementary 

Reading 
Complements 
in this Manual 

0 H Ben 3.1.5 2.1.a   
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2.2. Measurement practice of time parameters 

The definitions of MOSFET time-related parameters used in the dynamic state analysis in Ref. C 
can be described as “physical” since they represent the actual duration of physical processes 
occurring in the device. Unfortunately, it is impossible to use them in practice. Due to the fact that 
all transients theoretically end only in infinity, it is impossible to determine exactly when, for 
example, the uDS voltage reaches its steady-state value of UDS(off). 

Therefore, in measurement and design practice, technical definitions of time parameters 
according to IEC 60747-8-4 standard are applied. It is based on them that the parameters given in 
transistor data sheets are measured. In the technical definitions, instead of ideal steady states, the 
moments when waveforms attain the characteristic relative values of 10% and 90% are considered. 
Relative value here means a value related to the steady-state high level. 

In the case of the MOSFET, the uGS and the uDS voltages are reference waveforms wherein the 
initial value of uGS should be 0 V, as shown in Fig. 1. Thus, the considered relative values can be 
formally described with the formulae: 
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Fig. 1. Technical definitions of power MOSFET time parameters according to IEC 60747-8-4 standard 

The technical definitions of MOSFET time parameters can be expressed in words as follows: 

� the turn-on delay time td(on) is the time interval from the moment in which the 
relative value uGS(r) of the rising uGS voltage reaches 10% to the moment in which 
the relative value uDS(r) of the falling uDS voltage attains 90%; 

� the rise time tr is the time interval during which the relative value of the uDS 
voltage drops from 90% to 10%; 

� the turn-off delay time td(off) is the time interval from the moment in which the 
relative value of the falling uGS voltage attains 90% to the moment in which the 
relative value of the rising uDS voltage reaches 10%; 
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� the fall time tf is the time interval during which the relative value of the uDS 
voltage rises from 10% to 90%. 

The total turn-on and turn-off times are defined as sums of the relevant component time 
intervals, so their technical definitions are identical to the physical ones. 

Special measurement systems are designed so as to obtain waveforms maximally resembling 
ideal ones. However, effects of parasitic components may be observed in the form of overcurrents, 
overvoltages and oscillations, as illustrated in Fig. 1 for the uDS voltage during turn-off. If, as a result 
of such distortions, the voltage level referred to in a definition is crossed several times, it is always 
the first crossing of this level by the relevant waveform that should be considered. This is due to the 
fact that even distorted voltages cannot change more rapidly than allowed by the physical 
mechanisms acting in the semiconductor structure. Thus, the reference level is always reached 
within a time resulting from the device properties, which are what we want to investigate. On the 
other hand, the fact of crossing the reference level (overvoltage) and the following tendency toward 
the steady state (further oscillations) results from the parameters of the operating circuit and should 
therefore not be taken into account. 

Analysing the data sheet of the transistor under investigation, it can be seen that its 
manufacturer gives the time parameter values for strictly defined supply and drive conditions. These 
are therefore sample values, enabling an indicative comparison of different devices one with 
another. In a real circuit, these parameters may be significantly different, since the effect of the 
transistor’s operating circuit and conditions is significant. 
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3. MOSFET Power Loss 

3.1. Recommended Reading 

Ref. Textbook Excerpt 
Equivalent in the 

Polish Manual 
Complementary 

Reading 
Complements 
in this Manual 

D Ben 10.3.3 3.1.b, 3.2.a, 3.3.a   

   3.3.d  3.2 

Additionally, from Manual 0 references: 

Ref. Textbook Excerpt 
Equivalent in the 

Polish Manual 
Complementary 

Reading 
Complements 
in this Manual 

0 G Ras 6.3.2 3.3.b   
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3.2. Measurement practice of dynamic energy dissipation 

I we consider only the drain circuit, measuring the energy dissipated in a MOSFET in dynamic 
states always requires recording iD and uDS waveforms, their multiplication and integration: 

 ∫∫ ==
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where tinf(on) and tsup(on), and tinf(off) and tsup(off) are the integration limits.1 

To enable practical measurements and, at the same time, result standardization, the integration 
limits are determined based on characteristic relative values of relevant waveforms, as for the 
dynamic state limits necessary to determine the time parameters (see Section 2.2). According to IEC 
60747-8-4 standard, when energy is concerned, the tinf and tsup moments are defined by the relative 
values of 10% of iD and of uDS waveforms, as illustrated in Fig. 2. 
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Fig. 2. Measurement method for energy dissipated in the MOSFET in dynamic states 
according to IEC 60747-8-4 standard 

Since inductive load is most characteristic for devices operating in power electronic converters 
and it involves higher power loss, the standard requires it for measuring the energy parameters of 
MOSFETs. However, in this exercise measurements will be carried out under resistive load, for two 
reasons: 

1º to observe the relation to the time parameters, which in turn are required by the 
standard to be measured in a circuit with resistive load; 

2º to carry out the measurements during one laboratory session, which excludes 
load replacement. 

                                                      
1 In the case of macroscopic characterization of power semiconductor devices, the symbol E has been 

customarily adopted (also in the standard) for energy dissipation . However, in accordance with references and 
the majority of scientific publications and textbooks, we will use the symbol W, for two reasons: 1° to 
distinguish energy from electric field and 2° for consistency with reference chapters on energy bands and 
energy transfer in power conversion systems. 
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C 

Experiment 

4. Measurements 

4.1. Measurement set-up for dynamic parameters 

The schematic of the experimental set-up is presented in Fig. 3. Using blue screw terminal blocks 
on the panel, it is possible to insert in the circuit: 

� a gate resistor RG through the 2-pin block, 

� a load resistor (receiver) RL through the 4-pin block (only one pair of its 
terminals will be used while the other one will stay shorted), 

� the transistor under investigation T through the 3-pin block, whose connection 
in the circuit should be determined by comparison of connections shown in Fig. 
3 to the ones shown on the circuit’s panel. 

The IRF540N MOSFET will be investigated in this exercise. One of the larger-size 50-watt heat 
sink-equipped resistors available at the laboratory stand will be used as the receiver. One of the 
standard small-size 0,25-watt resistors will be used as the gate resistor. 

In order to eliminate the influence of self-heating on operation of the transistor under 
investigation as well as to enable a large current to flow without the risk of damaging the transistor 
by overheating, measurements are performed using single driving pulses that switch the transistor 
(turn it on and, after a short while, turn it off). A rectangular pulse of the ug voltage is generated 
each time the red button on the panel is pressed (the K4 switch in Fig. 3); the pulse duration tp (see 
Fig. 6) is a few dozens microseconds and its amplitude is roughly equal to the control circuit supply 
voltage UGG. 

Thus, after each change of settings in the measurement set-up, it is necessary to generate a 
switching pulse. This also applies to the situation when changes were only applied to the measuring 
equipment (oscilloscope, current probe). Only after a new pulse is generated will the oscilloscope 
record waveforms using the new settings and their changes will have any effect. Before it happens, 
even if it appears that e.g. waveforms have been zoomed horizontally (decrement in the time base), it 
is not true. In the oscilloscope’s memory, data recorded with the old settings are still present; it is 
only that the spacing between points has been increased. This kind of zoom may be compared to a 
camera’s digital zoom: it does not cause the image to be recorded with greater accuracy, it is just 
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stretched. The oscilloscope used in this exercise indicates this by displaying waveforms in grey 
instead of black. The above also applies to the vertical zoom (changing the oscilloscope’s voltage 
gain or the current probe amplifier’s current/voltage conversion ratio). 
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Fig. 3. Experimental set-up schematic (in the case of screw terminal blocks, only electrical connections are 
represented, not their real layout in space) 

Two 2-section power supplies will be used to energise the experimental set-up: 

� on with independent section operation (with only one of them used), for the 
control circuit (UGG and gate supply in Section 4.2); 

� one with series section operation which will enable obtaining a higher voltage, 
for the power loop (UDD). 

The circuit enables measurements of inter-terminal voltages and drain current of the device 
under investigation. Voltage measurements are performed using voltage probes appropriately 
connected to banana sockets labelled as vS, vG and vD in Fig. 3. Banana connectors with leads that 
enable attaching a probe are provided for this purpose. These connectors may be freely moved 
depending on current measurement needs. 

Current measurements are performed by clamping the current probe around the wire fragment 
led above the panel marked as iD in Fig. 3. The arrow on the probe indicates the direction assumed as 
positive. The probe should be so oriented that this direction is in line with the reality. 

Oscilloscope data are recorded using the WaveStar for Oscilloscopes application, which is 
accessible from the Start Menu under Pomiary, following the procedure described later in this 
manual. 
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4.2. Principal circuit resistance 

The block diagram of the measurement set-up is presented in Fig. 4. It should be assembled in 
the way described below and following the specified order of actions. 

1. Ensure that the power supply is turned off. Set it into the independent section operating mode 
(two buttons in the middle of the front panel, whose functions are explained above on the 
panel). Turn all the knobs of the power supply down to zero (extreme counterclockwise 
position). 

2. Turn on the power supply. 

To avoid damaging the transistor’s gate by an electrostatic discharge, perform all the 
manipulations with it after grounding yourself, e.g. by touching the ground of an 
oscilloscope input! Do not touch the transistor’s leads; only grab it by its plastic case or its 
metal base (heat sink). 

3. Mount the transistor under investigation in the 3-pin terminal block on the circuit’s panel, 
according to the circuit schematic (compare Fig. 3 to the drawing on the panel) and transistor 
terminal arrangement shown in the TO-220 package data sheet which is attached to this manual. 

4. Ensure that the control circuit and the power circuit loops remain open: 

� no gate resistor RG is mounted in the appropriate terminal block, 

� at most one pair of the 4-pin terminal block is shorted with a bare wire whereas the 
other one remains free. 

5. Using banana-terminated wires, bring voltage from one of the adjustable sections of the power 
supply between gate and source of the transistor so that the uGS voltage is positive, i.e., connect: 

� positive terminal of the power supply to transistor’s gate (vG socket), 

� negative terminal of the power supply to transistor’s source (vS socket), 

� additionally grounding the negative terminal by connecting it to the GND terminal. 

Multimeter 
PC510a

mA

Ω

A COM VΩ

Experimental Set-up UD-9

−

+
UGG

−

+
UDD

Power Supply PTA60-3QD

− + − +
SLAVE MASTER FIXED

− +GND GND

INDEP.

T

 
Fig. 4. Block diagram of the measurement set-up for drain-to-source resistance measurement 

6. Slightly increase the limiting current (Current knob) of the power supply until the red current 
limiting indicator goes out. 

7. Turn on the multimeter and set it to resistance measurement mode. Connect original test probes 
to the appropriate (for resistance measurements) terminals of the meter. 
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If battery discharge indicator (a battery symbol) shows up on the meter’s display, do not 
continue measurements but ask the teacher to replace the battery. Otherwise meter 
indications may become erroneous. 

8. Using the multimeter, measure the drain-to-source resistance RDS of the transistor, by touching 
its appropriate leads mounted in the terminal block (not to any other points in the measurement 
set-up located anywhere else) with the test probes: 

� the drain lead, with the probe connected to the meter’s common socket (COM), 

� the source lead, with the probe connected to the meter’s resistance measurement socket 
(Ω). 

Write down the indication of the meter RDS with an accuracy of two significant digits. 

Before proceeding with the following step, connections and settings must be checked by the 
teacher. To avoid losing time, perform step 4.3/1 while waiting for the check. 

While carrying out the following step, the voltage set in any moment cannot exceed 15 V as 
this may cause the transistor to break down. 

9. Gradually increase the power supply voltage (not exceeding 10 V, however). Write down the UGS 
voltage at which the RDS resistance drops drastically, i.e. by at least three orders of magnitude. 
Write down this resistance itself as well. 

The expression “at least” means that the size of the drop cannot be lower than the one given, whereas 
it can be larger. It does not mean that the size of the drop must be exactly the one given, so you 
should not waste time for accurately setting the voltage to obtain any specific resistance value. 

10. Measure the drain-to-source resistance for the transistor fully on: 

(a) calibrate the meter for small resistance measurements: 

� short the tips of the test probes together, 

� wait for the meter’s indication to settle, 

� with the probe tips still shorted together, push the Range button to start the wire 
resistance compensation procedure, 

� the “Shrt” (short) message should show up on the display for 3 sec., after which the 
reading of 0 should be displayed, 

� open the test probe tips; 

(b) set the voltage of 10 V on the power supply; 

(c) touch the appropriate leads of the transistor mounted in the terminal block with the test 
probes: 

� the drain lead, with the probe connected to the meter’s resistance measurement socket 
(Ω); 

� the source lead, with the probe connected to the meter’s common socket (COM); 

write down the indication of the meter RDS. 

11. Bring the supply voltage back to zero and turn off the power supply. 

12. Turn off the meter. 
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4.3. Preparing for time waveform recording 

Measurement circuit set-up 

The block diagram of the measurement set-up is presented in Fig. 5. It should be assembled and 
configured in the way described below and following the specified order of actions. Connections 
existing at this moment and resulting from the previous section should not be removed; a procedure 
will be given for their appropriate modification. 

To avoid losing time, proceed with the subsequent steps in parallel with step 1. 

1. Turn on the computer. After logon is finished, turn on the oscilloscope and set up the 
connection with the computer closely following the manual available at the laboratory stand. 

2. Connect the power supply to the experimental circuit: 

(a) ensure that both power supplies are turned off; 

(b) using two buttons in the middle of the front panels, set the section operation mode: 

� on one power supply, which will be used for the control circuit, independent (this 
setting should already be done within Section 4.2), 

� on the other power supply, which will be used for the power loop, series; 

(c) turn all the knobs of both power supplies down to zero (extreme counterclockwise position); 

(d) remove the short between the “−” terminal and the ground (GND terminal); 

(e) connect the terminals of one of the adjustable sections of the control circuit power supply 
[see sub-step (b)] to the UGG sockets on the circuit’s panel by switching over wires from vS 
and vG sockets to UGG sockets keeping the polarity as indicated on the power supply; 
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−
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+
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OUTPUT
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Fig. 5. Block diagram of the measurent set-up for recording time waveforms 
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(f) connect the extreme terminals of the power loop supply (Slave section − and Master section 
+) to the UDD sockets on the circuit’s panel 

3. From the web page, obtain and write down the power loop supply voltage Ui and the desired 
load current Io. 

4. Mount necessary components in the blue screw terminal blocks on the circuit’s panel: 

(a) in the 2-pin terminal block, mount a small-size (0,25-watt) resistor RG of 470 Ω (the 
resistance can be determined using the multimeter operating in the ohmmeter mode); 

(b) short one of the terminal pairs of the 4-pin block with a short bare wire available at the 
laboratory stand (unless this is already done); 

(c) using Ohm’s law, calculate the load resistor resistance RL such that with the power loop 
supply voltage UDD determined in step 3, after transistor is turned on, a current Io 
determined in step 3 flows in this loop (for this sake, assume that the transistor is an ideal 
switch, i.e., that the on-state resistance between its main terminals is zero); 

(d) to the other terminal pair of the 4-pin block, connect a power (50-watt, in a metal casing, 
with short lead wires) resistor on short wires with a resistance closest to the value calculated 
above; 

Values of electronic component parameters, normally in the form of “a.b U,” where a is an integer 
part, b is a decimal part and U is a unit, are frequently written as “aUb.” 

The metallic resistor case cannot at any time touch any other metallic parts. This might 
result in a short-circuit and a consequent damage of the circuit and of the device under 
investigation! 

(e) in parallel to the RL resistor, in sockets located under the 4-pin terminal block, mount the 
clamping diode D0 available at the laboratory stand (with banana plugs on its leads) keeping 
the appropriate polarity as shown in Fig. 3 (the cathode is marked with a strip on diode’s 
case). 

5. Connect two 10:1 attenuation voltage probes so that the gate-source voltage uGS is measured on 
the oscilloscope’s channel 1 and the drain-source voltage uDS is measured on channel 2. If only 
one of the probes has a ground connector available, it should be used to measure the uDS voltage. 

Warning! 

1. Voltage probe grounds (alligator clip connectors) are shorted together in the oscilloscope 
and connected to the supply network’s protective earth. They must be therefore always 
connected to a same potential. Any other connection may result in current flowing through 
the oscilloscope, which will damage its input circuitry! 

2. During measurements, do not touch elements where power circuit supply voltage is 
present (especially the drain potential connector vD, transistor’s metallic embedded heat 
sink, load resistor’s leads, clamping diode’s leads). 

3. Before proceeding with the following step, connections must be checked by the teacher! 

4. Read each of the steps 6 and 7(b) entirely, including comments below them, before 
executing them! 

6. Turn on the control circuit power supply. If measurements from Section 4.2 have been omitted, 
slightly increase the current limiting threshold (Current knob) until the red current limiting 
indicator (C.C.) goes out. 

Set the control circuit supply voltage (Voltage knob) to 10 V; if current limiting is activated in 
the course of setting, decrease the voltage first, increase the current limiting threshold and only 
then try to increase the voltage again. 

Under correct circuit operation, the power supply’s ammeter should indicate a current of 
the order of tens of milliamps. If something different is observed during or after setting, 
turn off the power supply immediately and ask the teacher to check your circuit again. 

Be careful not to exceed 18 V during voltage setting or the integrated circuits could be 
damaged. 
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7. Energise the power loop: 

(a) turn on the power loop supply; 

(b) slightly increase the current limiting threshold in both sections of the power loop supply 
(Current knobs) until red indicators go out (C.C.); 

(c) using the Master section Voltage knob (which controls both section voltages in series mode), 
set the power loop supply voltage to the value determined in step 3 (it is the sum of Slave 
and Master section voltmeter indications that should be made equal to that value as the 
circuit is supplied by a series connection of the two sections). If current limiting is activated, 
proceed as instructed in step 6. 

The red LED indicator on the circuit’s panel should light up. 

Under correct circuit operation, the power supply’s ammeter should not indicate any 
current flow apart from a constant current of the LED indicator (about 0,02 A) and a 
transient charging current of a stabilising (bulk) capacitor found inside the circuit (not 
more than 0,05 A). If something different is observed during or after setting, turn off the 
power supply immediately and ask the teacher to check the circuit again. 

8. Using the oscilloscope communication software, upload to the oscilloscope the initial settings 
that can be found in the appropriate network folder: 

� choose File ‣ Open from the menu and open the file, choosing Offline in the dialog that 
appears next: 

[AM503B amplifier] ustawienia_3a_am503.sht; 

[TCPA300 amplifier] ustawienia_3a_tcpa300.sht; 

� on the list displayed in the left panel, unfold the installed oscilloscope, Data, Settings; 

� in the settings file window, select its entire contents and drag them to the Full Setup 
item in the left side panel using the mouse; 

� wait for the introduction of settings on the oscilloscope to complete, which process is 
indicated by changes of elements on the screen (letters, numbers, curves). 

Trial measurement 

9. Using Ch1/2/3/4 Menu buttons on the oscilloscope, display the waveform from channel 1 and 
hide waveforms from all the other channels. 

Chx Menu buttons (where x is channel number) cause toggled displaying and hiding the waveform 
form a given oscilloscope channel. When a given waveform is displayed, this is indicated by an arrow 
left of the graticule showing the zero level as well as channel symbol “CHx” under the graticule. 

10. Generate the switching pulse by pushing the red button on the circuit’s panel. On the 
oscilloscope, the message “Trig’d” (Triggered) should momentarily appear above the graticule 
and the uGS voltage waveform should be displayed. If this does not happen, ask the teacher to 
check oscilloscope settings. 

11. Adjust (generating the switching pulse after each change is made) the time base and the trigger 
event position (Sec/Div and Position  knobs) so that the entire pulse of the uGS voltage is visible 
(see Fig. 6) and occupies most of the display horizontally. 
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Fig. 6. Voltage and current waveforms during MOSFET switching 

12. Using the Ch2 Menu button, display the waveform from channel 2, i.e. the uDS voltage. Check 
whether the waveform is correct (see Fig. 6). 

13. If any of the waveforms extends beyond the display (ignore short spikes for now if observed), 
adjust the appropriate channel gain and zero-level position (Volts/Div and Position knobs). 

14. Using the Ch4 Menu button, display the waveform from channel 4 (its current shape is not 
important now). 

15. Configure the current probe and its connection to the oscilloscope following the short manual 
available at the laboratory stand. Obligatorily read and follow the oscilloscope configuration 
guidelines given in that manual. 

At the appropriate moment: 

� connect the amplifier’s output to the oscilloscope’s channel 4; 

� initially set the current/voltage ratio to a value enabling measuring and displaying on 
the oscilloscope a current waveform with the amplitude Io determined in step 3 [see 
information about current probe amplifier operation and its interaction with the 
oscilloscope in the probe manual]. 

16. Set DC coupling on the current probe amplifier. 

17. Clamp the probe around the appropriate wire fragment so that the drain current iD is measured 
and that its measured sense is in accordance with the real one (considering the connections 
diagram shown on the measurement set-up panel). 

18. Generating the switching pulse, adjust: 

� measurement path gain as described in the probe manual, and 

� waveform position using the Position knob for channel 4 (on the oscilloscope), 

so that the current waveform is visible in an optimal way, i.e. it maximally fills the screen 
vertically but does not extend beyond. Check whether the waveform is correct (see Fig. 6). 

If the current probe amplifier conversion ratio has been considerably changed (by an order of 
magnitude or more), then the calibration and de-gauss procedure must be repeated after the 
probe is closed without any wire inside. 
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4.4. Waveform measurements realisation 

Full switching cycle 

1. Generate a switching pulse. Ensure that the waveform image is still correct. Check if the current 
pulse amplitude observed on the oscilloscope is approximately equal to the value determined in 
step 4.3/3 (check the guideline concerning the voltage/current ratio readout in the current probe 
manual). 

Skipping the above step may cause a lot of trouble during result elaboration! 

2. If needed, adjust: 

� the voltage gain in voltage measurement channels (1 and 2) using the Volts/Div knob, 

� the gain along the current measurement path, as described in the current probe manual, 

� waveform positions using the Vertical Position knobs, 

so that each waveform, from its zero level (indicated by the arrow left to the graticule) to its 
maximum value, occupies a maximum potion of the entire display area vertically but does not 
extend beyond the display (still ignore short spikes if present). 

3. Record all the three waveforms of uGS, uDS and iD (together): 

(a) in WaveStar application, create a new YT Sheet type sheet; 

(b) from the side panel (Local ‣ oscilloscope’s name ‣ Data ‣ Waveforms ‣ channel’s symbol) 
drag the three signals displayed on the oscilloscope’s screen to the sheet created; 

Once dragged to the sheet, waveforms may be just refreshed in the future by pressing the Refresh 
Sheet button or by choosing View, Refresh Datasheet from the menu. 

A waveform can be deleted from the sheet by clicking its number left of the graticule and hitting 
the Delete key. 

(c) save the sheet containing all three signals in the WaveStar format (SHT) – Save Datasheet 
(Ctrl+S) button; 

Don’t use Save Worksheet as it does not save any measured data, only names of opened sheets. 

(d) write down the current setting of the current probe gain (see “Current/voltage Conversion” 
section in the current probe manual; if this manual states that conversion is not needed, then 
the value of 1 A/V should be written down). 

Detailed turn-on observation 

4. Record waveforms that will enable determining the time and energy-related dynamic 
parameters for transistor’s turn-on (not for any other operating state): 

(a) set the time base (Sec/Div), the trigger event position (Horizontal Position) and, if needed, the 
trigger level (Level) so that the process of transistor’s turn-on process (not any other 
operating state) both in the main and in the control circuit, i.e. along the ton(g) interval (see 
Fig. 6), can be observed with the highest possible accuracy; 

(b) if, due to the imperfect operation of the current probe, the off-state current value seen on 
the oscilloscope—which is known to be imperceptibly small at current scale—is not shown 
exactly at the zero level of the relevant oscilloscope channel (marked with an arrow left of 
the graticule), the current waveform should be appropriately shifted in the current probe 
amplifier so that this value is shown exactly at this level: 

� [AM503B amplifier] using the Output DC Level knob, 
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� [TCPA300 amplifier] using the Manual Balance �/� buttons (due to the large current 
amplitude, this button must be depressed for a dozen seconds for the waveform shift to 
become noticeable); 

Failure to perform the above sub-step may lead to incorrect results. 

(c) make sure that all the instants of all the level crossings needed to determine all the turn-on 
time parameters are visible on the screen (see Fig. 1), otherwise adjust the time base 
(Sec/Div), the trigger event position (Horizontal Position) and, if needed, the trigger level 
(Level); 

(d) make sure that channel settings are still conforming to the requirements given in step 2, but 
this time including any overvoltages if present, otherwise modify them according to step 2; 

(e) in the WaveStar application, create two new sheets: one YT Sheet type and one Power 
Harmonics type; 

Among others, a Power Harmonics sheet enables multiplying two waveforms. If these waveforms 
are some current i flowing between two circuit nodes and the voltage u between these nodes, 
then the obtained u×i product will by definition be the instantaneous power p dissipated in 
components connected between these nodes. 

(f) use the Power Harmonics sheet to calculate the waveform of the instantaneous dissipated 
power pD: 

� from the side panel, drag the iD waveform to the Current Waveform window in the lower 
part of the Power Harmonics sheet; 

� to the Voltage Waveform window, drag the waveform of the voltage appropriate for 
obtaining the power dissipated in transistor’s drain circuit pD (not any other waveform 
product); 

The following point should be first read in its entirety including remarks below and 
only then you should proceed with its execution. 

(g) drag all the four waveforms of uGS, uDS, iD and pD  to the YT Sheet; 

To avoid losing time for downloading all the signals from the oscilloscope again (this 
action is yet to be repeated several times), all the three waveforms already displayed in 
the Power Harmonics window should be dragged from this sheet, not from the side 
panel. Only the lacking waveform must be dragged from the side panel. 

Before all the measurements described in this manual are completed, no waveform settings 
should be changed in WaveStar. The only exceptions allowed are: 

� changing the colour from the toolbar at the top of the sheet window; 

� shifting the zero level using the arrow found left of the graticule; 

� shifting the triggering event as described in sub-step (h). 

Any other change will make it impossible to use the refresh function, which will make carrying 
out of this exercise considerably longer. 

(h) it will be usually necessary to synchronise the power waveform with the other ones; for this 
purpose, select the power waveform by clicking on its number displayed left of the graticule 
and then place the coloured slider above the graticule exactly between the white markers in 
the form of brackets; 

(i) save the YT Sheet containing the set of four waveforms and write down the current setting 
of the current probe gain (if changed). 

5. Turn off the power loop supply. Replace the gate resistor RG with a 220 Ω one. Turn on the 
power supply. 
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After the power supply is turned on again, current limiting may be temporarily activated. It should 
turn off automatically after the capacitor at the input of the experimental circuit fully reloads. This 
should not take more than a few seconds. 

6. Obtain and record waveforms under new conditions: 

(a) generate a switching pulse; 

(b) make sure that all the instants of all the level crossings needed to determine all the turn-on 
time parameters are visible on the screen (see Fig. 1), otherwise adjust the time base 
(Sec/Div), the trigger event position (Horizontal Position) and, if needed, the trigger level 
(Level); 

(c) if, due to the imperfect operation of the current probe, the off-state current value seen on 
the oscilloscope—which is known to be imperceptibly small at current scale—is not shown 
exactly at the zero level of the relevant oscilloscope channel (marked with an arrow left of 
the graticule), the current waveform should be appropriately shifted in the current probe 
amplifier so that this value is shown exactly at this level: 

� [AM503B amplifier] using the Output DC Level knob, 

� [TCPA300 amplifier] using the Manual Balance �/� buttons (due to the large current 
amplitude, this button must be depressed for a dozen seconds for the waveform shift to 
become noticeable); 

(d) make sure that channel settings are still conforming to the requirements given in step 2, but 
this time including any overvoltages if present—otherwise modify them according to step 2; 

(e) first, refresh the Power Harmonics sheet (activate this sheet and click the Refresh Sheet button 
or choose View ‣ Refresh Datasheet, not Refresh Workbook, from the menu); 

(f) next, refresh the YT Sheet in the same way; 

(g) synchronise the power waveform with other ones; 

(h) save the YT Sheet containing the set of four waveforms and write down the current setting 
of the current probe gain (if changed). 

Detailed turn-off observation 

7. Record waveforms that will enable determining the time and energy-related dynamic 
parameters for transistor’s turn-off: 

(a) before taking any other action, change the triggering edge to falling (Trigger Menu, Slope); 

Failure to carry out the above sub-step will make exercise realisation considerably 
longer, i.a. by making it more difficult to obtain the instantaneous power waveform 
image in the PC application. 

(b) repeat step 6 in its entirety, i.e. all of its sub-steps (and not only selected ones), except that 
when assessing correctness of the observed waveforms, obviously the turn-off process 
should be considered instead of turn-on. 

In most cases, failure to carry out sub-step 6(b) will make it impossible to read the 
necessary numerical data out of the image observed during result elaboration. Failure to 
carry out sub-step 6(c) may lead to incorrect results. 

8. Replace the gate resistor RG with the 470 Ω one again, proceeding as in step 5. 

9. Repeat step 6 in its entirety, i.e. all of its sub-steps (and not only selected ones), still considering 
turn-off instead of turn-on. 

Gate circuit at a zero drain-source voltage 

10. * Bring the UDD voltage to zero. 

11. * Change the triggering edge to the rising one (TRIGGER MENU, Slope). 
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12. * Using a new YT Sheet, record voltage waveforms only (i.e. uGS and uDS) for turn-on state. 

Measurement completion 

13. [AM503B amplifier] On the current probe amplifier, bring the Output DC knob setting (which is 
displayed in the Current/Division field during setting) to the value of 0,0. 

14. Bring the power loop supply voltage down to zero. Wait until the red LED indicator on the 
circuit’s panel goes out. 

15. Bring the control circuit supply voltage down to zero. Turn off the power supplies and 
disconnect the set-up. Dismount the load resistor, the gate resistor and the transistor; do not 
remove the bare shorting wire from the 4-pin terminal block. Tighten the screws in terminal 
blocks that have become unoccupied. 
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D 

Results 

5. Results Processing 

5.1. Static state parameters 

1. Run the WaveStar application. 

2. Open the waveform set {uGS; uDS; iD} for the full driving voltage pulse—recorded in step 4.4/3. 

3. Based on of the current probe’s current/voltage conversion ratio written down, calculate the 
coefficient ki in amps per volt, which will be used to multiply a value shown in Wavestar in volts 
in order to obtain a corresponding real current value in amps. 

Values shown in WaveStar for current waveforms are indeed voltage values that came from the 
current probe amplifier and were recorded by the oscilloscope. We will denote this with an asterisk. 
This voltage is proportional to the current according to the current probe conversion ratio written 
down. The coefficient, resulting directly from this ratio, but for practical reasons expressed in SI units, 
i.e. A/V, will allow obtaining real values in amps. The real value of current in amps is i [A] = ki [A/V] 
∙ i* [V]. (According to the A6302/A6312+AM503B current probe and amplifier manual, the value 
indicated on the display was expressed in A/10 mV or in mA/10 mV.) If, for example, the current 
probe conversion ratio has been 5 A / 10 mV, then ki = 5 A / 10 mV = 500 A/V.  

4. Based on the oscilloscope image, estimate the transistor’s operating point parameters in the on-
state (see Fig. 6): 

(a) using a horizontal cursor, read out the drain current value ID(on)* (in volts); 

Slight overshoots that sometimes may be seen in the current waveform (upwards after turn-on, 
downwards after turn-off), result only from the limited frequency bandwidth of the current 
probe. They should be therefore neglected during analysis. If there is an overshoot with 
considerable amplitude, it should be assumed that the high level of the current pulse is indeed a 
horizontal line at the level that the waveform attains after the visibly faster growth in the 
beginning of the pulse. 

Remarks on the use of cursors in the WaveStar software: 

1. In order to activate cursors, chose View ‣ Properties ‣ Cursor from the menu and select a cursor 
type appropriate for the measurement. In the active YT Sheet, values related to the active 
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waveform will appear, depending on the cursor type selected:X, Y – the coordinates of the active 
cursor (continuous line); 

— X1, Y1 and X2, Y2 – the coordinates of the first and the second cursors; 

— dX, dY – the differences of the two cursors’ coordinates. 

2. A waveform can be activated by clicking its number shown left of the graticule. The number of 
the active waveform is constantly highlighted. 

3. After switching to another waveform, a horizontal cursor remains on the same level in volts 
(not in divisions). This means that when a large difference in vertical scales (V/div) is present 
between the two waveforms, the cursor can be placed beyond the display. In such a situation, 
temporarily increase the V/div coefficient, then move the cursor to a level close to zero and after 
that restore the previous coefficient value.  

4. Distinguishing different waveforms will be easier when coloured legend is chosen: in the menu 
View ‣ Properties ‣ Plot, select Waveform notes color match waveform color. 

(b) using the coefficient ki determined in step 3, calculate the real drain current value (in amps) 
ID(on); 

(c) check if the ID(on) value determined conforms with test circuit data and settings [see Section 
4.1 and step 4.3/3]; if not, identify the source of this discrepancy (e.g. an improper gain 
setting on channel 4 of the oscilloscope different from 10 mV/div in the case of a current 
probe with the AM503B amplifier, a mistakenly noted current probe amplifier indication, 
wrong load resistor network configuration) because the ki coefficient is very important for 
calculations that follow; 

(d) using a horizontal cursor, read out (approximately) the drain-source voltage value UDS(on); 

(e) * based on results obtained, calculate the approximate on-state drain-source resistance 
RDS(on). 

5. Based on the oscilloscope image, determine the voltage and current values necessary for using 
the definitions of time and energy parameters as prescribed in the standard (see Sections 2.2 and 
3.2): 

(a) using a horizontal cursor, read out steady-state values of: 

� the on-state gate-source voltage value UGS(on), 

� the off-state drain-source voltage value UDS(off); 

(b) using values read out in sub-step (a) and in step 4, calculate the absolute values, i.e. in Volts 
(or Amps, however, using iD* values will be easier) not in percents, corresponding to the 
different percent values appearing in the technical definitions of time and energy 
parameters, according to the IEC 60747­8‑4 standard. 
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5.2. Turn-on and turn-off parameters 

Starting Scilab 

1. Run the numerical computation package Scilab. 

2. In order not to have to enter the full path for all the processed files (WaveStar output files), the 
working directory may be changed to the directory that contains them by executing the 
command: 

cd('measurement_data_path’); 

3. Load the script that contains functions necessary for dissipated energy calculation by executing 
the command (add the file path if needed): 

exec('wavestar_calka.sce'); 

where script_path is the path for the file wavestar_calka.sce (\\pum1\wspolnelab\pium\skrypty in 
the laboratory; the script is also available on the course web site). 

Time-related dynamic parameters 

4. In WaveStar, open the waveform set {uGS; uDS; iG; pG} for the turn-on process, for RG = 470 Ω, 
recorded in step 4.4/4. 

5. Determine the time-related dynamic parameters for turn-on: 

(a) using paired cursors, read out the turn-on delay time td(on) according to its technical 
definition as prescribed in the standard (see Section 2.2), using the values calculated in step 
5.1/5 (see Fig. 7); 

Exemplary readings presented on the figures in this subsection show only the way how the 
parameters should be measured. They do not suggest any correct values, and the way that 
waveforms should look like in the sheet. In order to get exemplary results more readable, 
oscilloscope images contain only waveforms necessary to understand particular section. 

(b) using paired cursors, read out the rising time tr according to its technical definition as 
prescribed in the standard. 

6. * Using a paired cursor, read out the approximate value of the threshold voltage UGS(th) (see Fig. 
6). 

Energy-related dynamic parameters 

7. Based on the current probe current/voltage conversion ratio previously written down, determine 
the ki coefficient for the image under processing (this is not needed if amplifier settings were not 
changed; the value calculated in step 5.1/3 stays valid then). 

Values of instantaneous power result from multiplication of voltages recorded in the appropriate 
oscilloscope channels. One of them was equal to a real voltage while the other was proportional to 
the current accordingly to the current probe conversion ratio. Values of in the power waveform are 
therefore indicated in volts times volts. The coefficient, directly related to the current probe 
conversion ratio and expressed in A/V, will allow converting this unit to 1 (V×V)∙(A/V) = 1 V×A 
= 1 W. 

If, for example, the current probe coefficient has been 1 A / 10 mV, then ki = 100 A/V. The real 
instantaneous power value in watts is p [W] = i [A] ∙ u [V] = ki [A/V] ∙ i* [V] ∙ u [V] =  
ki [A/V] ∙ p* [V×V], where p* is the quasi-power value indicated in WaveStar. 

8. In WaveStar, determine the parameters of the power pulse generated during turn-on: 
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(a) using cursors, read out the peak value of the dissipated quasi-power PD(on)pk* (in V×V); 

(b) calculate the real value of power PD(on)pk (in watts) using the ki coefficient determined 
previously; 

(c) using cursors, read out coordinates of the integration limits tinf(on) and tsup(on) according to 
what is prescribed by the standard with respect to the turn-on energy WD(on) (see Section 3.2 
and Fig. 9); 

(d) export the data to a CSV (comma-separated values) text file from the menu File ‣ Export 
Datasheet ‣ CSV. 

9. In Scilab, calculate the energy dissipated during turn-on WD(on): 

(a) read in the data exported by executing the command 

[header,data]=wczytaj_ws('file_name.csv'); 

During calculations for subsequent cases, a previously executed command can be recalled using 
the ↑ key. 

(b) calculate the energy WD(on) as the integral of pD for the inverval from tinf(on) to tsup(on), taking 
the ki coefficient into account, by executing the command: 

calka_infsup(data,pd_waveform_no,tinf,tsup,ki) 

The parameter pd_waveform_no is the number of the pD waveform according to the increasing 
numbering in WaveStar software (not the channel number on the oscilloscope). If, for example, 
waveforms displayed in WaveStar are: 2) uDS, 3) iD, 5) pD, 6) uGS, then the pD waveform is the 
third consecutive, so pd_waveform_no = 3 should be entered; if numbering starts from 1 and there 
is no gap, then pd_waveform_no is identical to the one shown in WaveStar. 

An alternative version of the integral function can be used, calka_infint(). It works in a way 
identical to the previous one except that instead of the lower integration boundary tsup, it takes 
the integration time tint

 as a parameter. It may be more convenient because both readings (X and 
dX) can be copied from the YT Sheet at the same time. 

As an example, assuming that the sequence of waveform presentation in WaveStar has been as 
follows: 1) uGS, 2) uDS, 3) iD, 4) pD, and that other parameters have had values as in the sample 
Figures 8 and 9 (see figure captions): 

calka_infsup(dane,4,40E-9,876E-9,100) 

or 

calka_infint(dane,4,40E-9,836E-9,100) 

or 

calka_infint(dane,4,876E-9,-836E-9,100) 

(c) the above function returns the value of the integral in joules and, for verification purposes,  
plots the pD waveform and scaled by ki as well as fills the area that corresponds to the 
calculated integral; 

based on this plot check, verify (cf. Figs. 2 and 10): 

� whether the peak power value seen in the check plot (accordingly to Y-axis scale) agrees 
with the one calculated in step 8(b), 

� whether the integral has been calculated for a proper interval along the power 
waveform; 

if not, determine the integration limits correctly and re-calculate the energy; 

(d) save the plot check using the File ‣ Export command (PNG format is recommended). 

Further cases 

10. Repeat the steps 4 to 5 and 7 to 9 for the other RG value, using the set of waveforms recorded in 
step 4.4/6. 
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11. Repeat points 4 to 5 and 7 to 9 for the turn-off state, for RG = 470 Ω (the set of waveforms 
recorded in step 4.4/7) and for the other RG value (the set of waveforms recorded in step 4.4/6(g)) 
so as to determine the time-related dynamic parameters td(off) and tf and the energy-related ones 
PD(off)pk and WD(off). 

The overshoot that may sometimes be visible in the drain current waveform after the transistor is 
turned off, results from imperfection of the current probe. From this moment on, no current flows 
through the device and there cannot be any power dissipated in it. This overshoot should therefore 
not be taken into account when determining the tsup(off) moment. 

 
Fig. 7. Example of td(on) time readout, td(on) = 156 ns (dX indication). The Y value shows that the right cursor has 
been set at the first point where the relative value of the uDS waveform became less than 90% which in this case 
corresponds to 47,0 V. 

 
Fig. 8. Example of peak power readout, PD(on)pk

*
 = 371 mV×V. If, for example, ki = 100 A/V, then finally PD(on)pk = 

37,1 W. 
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Fig. 9. Example of tsup(on) coordinate readout, tsup(on) = 876 ns, from the uDS waveform (in this case, the  absolute 
value corresponding to the relative value of 10% is 5,20 V); the second cursor (at the iD waveform) points at the 
moment of tinf(on) = 40 ns. The length of the integration interval (the dX indication) is thus ∆tWon = 836 ns. 

 
Fig. 10. Plot check from Scilab for correct calculation of energy dissipated during turn-on for the waveforms of 
Figs. 8 and 9 
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5.3. Result summary 

1. Gather the results obtained in section 5.2 in a table (or two tables, for turn-on and turn-off 
separately) that contains for all the two RG cases the following (not any other) parameters: 

� RG; 

� td(on), tr, PD(on)pk, WD(on) for turn-on; 

� td(off), tf, PD(off)pk, WD(off) for turn-off. 

In order to make result analysis possible, all the times for all the cases must be given in the same 
unit; the same applies to all the power values and all the energy values. 

2. Calculate (see Fig. 16 in Ref. 13) and add to the table directly after the appropriate source 
parameters: 

(a) the total turn-on time ton; 

(b) the total turn-off time toff. 

3. In a separate row, calculate the rates of change (i.e. values telling how many times a parameter 
has changed, not by what amount it has) for all the above parameters (RG included) with the 
resistance changing from the smaller to the larger one (not the opposite). 
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6. Results Analysis 

6.1. Waveforms of electrical quantities during full switching cycle 

1. In the oscilloscope image of {uGS; uDS; iD} waveforms (for the full driving voltage pulse, step 
4.4/3), label the different operating states: off-state, turn-on, on-state and turn-off (see Fig. 6 and 
Ref. C). 

2. * In a separate copy of the oscilloscope image analysed in step 1, mark points, ranges or areas 
significant for transistor evaluation as a semiconductor switch (how close the device is to the 
ideal switch; see Manual 0, Ref. G). Briefly (even symbolically) describe the relevant conditions 
(what quantity should approach what value or size). 

3. In the oscilloscope image of {uGS; uDS; iD; pD} waveforms for turn-on and for turn-off, at 
RG = 470 Ω (waveforms recorded in steps 4.4/4 and 0), mark the time intervals where the 
transistor operates in the different regions: sub-threshold, saturation and linear (see Fig. 6 and 
Ref. C). 

4. * Based on the uGS voltage waveform during turn-on (the set of waveforms analysed in step 3) 
show that the input capacitance Cin changes its value in the course of this process (see Refs. B 
and C). Indicate the time interval where Miller effect can be observed. 

5. * What is the difference between the uGS waveform recorded in step 4.4/12 and the one recorded 
in step 4.4/4 (analysed in step 4)? How do these results prove that the increase in input 
capacitance results from Miller effect occurring?—explain the difference observed referring to 
the uDS voltage waveforms recorded simultaneously and Miller theorem is its original form, 
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(this is equivalent to the formula given in Ref. B, taking into account the definition of gfs and 
Kirchhoff’s Voltage Law, uDS = UDD − iD∙Z, for a resistive load Z). 
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6.2. Static parameters 

1. Which of the resistances measured in steps 4.2/8 and 10 is the off-state drain-source resistance 
RDS(off) and which is the on-state one RDS(on)? Calculate their mutual ratio; how many orders of 
magnitude is it? 

2. Based on the value of the off-state drain-source resistance RDS(off), estimate the transistor’s 
leakage current IDSS at the UDS(off) voltage determined in step 5.1/5. Assume for simplicity that 
the RDS(off) resistance does not change with the UDS voltage. 

3. Compare values and ratio determined in steps 1 and 2 to values of these parameters given in the 
data sheet of the investigated transistor. Justify discrepancies if observed considering: 

� measurement conditions and value spread of data sheet parameters, 

� multimeter measurement uncertainty which was ±0.06 Ω for the lowest range and ±1% 
for the 5 MΩ range. 

4. * Compare the value of the RDS(on) resistance measured with the multimeter to the one calculated 
based on oscilloscope measurement in step 5.1/4(e). Justify discrepancies if observed. 

5. Compare the UGS voltage at which the sharp drop in the RDS resistance has been observed as 
determined in step 4.2/9, to the threshold voltage UGS(th) given in the data sheet of the 
investigated transistor. 

6. * Compare the threshold voltage UGS(th) value estimated using the static method (step 4.2/9) to 
the one determined based on the oscilloscope measurement in step 5.2/6. 

7. Analyse the influence of the switch on the main loop of the investigated circuit: 

(a) compare the on-state drain-source resistance to the receiver resistance used in the 
experiment; does this mean that the semiconductor switch has important influence on the 
value of the current flowing in the main loop (refer to Ohm’s law)? 

A 10-percent threshold can be used as the limit of important influence, which is typical in power 
electronics. 

(b) compare the off-state drain-source resistance to the receiver resistance used in the 
experiment; does this justify the assumption that all the supply voltage UDD is dropped 
across the transistor when it is turned off (refer to the voltage divider formula)? 

8. In the oscilloscope image of {uGS; uDS; iD} waveforms (for the full driving voltage pulse, step 
4.4/3), mark the levels of UGS(on), UDS(off), ID(on) and UDS(on) (cf. Fig. 6). 

9. Justify the numerical values of the above levels determined in steps 5.1/4–5 based on conclusions 
from step 7 as well as known element values of the investigated circuit (including the sources, 
i.e. both supply voltages), and referring to Ohm’s and Kirchhoff’s laws. 

10. Analyse the power loss in the investigated transistor in either static state: 

(a) based on the RDS(on) and RDS(off) values measured and on the current or voltage values 
determined in steps 5.1/4–5, calculate the on-state and off-state instantaneous power loss in 
the transistor’s drain circuit, pD(ons) and pD(offs) (see Ref. A and use an analogical formula for 
the off-state); 

(b) do results obtained justify the assumption often adopted in practice (cf. Manual 0, Ref. G) 
that the off-state can be neglected as far as static power loss in a semiconductor switch is 
concerned? 
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6.3. Dynamic parameters 

1. Based on the results contained in the table, state what the effect of the gate resistance is on each 
of the transistor’s time parameters: td(on), tr, ton and td(off), tf, toff; perform a qualitative (rising / 
falling) and a quantitative (imperceptible / proportional / much stronger / much weaker). 

2. Explain your observations based on the MOSFET’s control circuit model in the form of the input 
capacitance (see Refs. B and C). 

3. Are the time parameter values determined of the same order of magnitude as those given in the 
device datasheet? Why? Take measurement conditions into consideration. 

4. Based on results contained in the table, state what the effect of the gate resistance is on each of 
the transistor’s energy-related parameters: PD(on)pk, WD(on) and PD(off)pk, WD(off); perform a 
qualitative and a quantitative analysis. 

5. Explain your qualitative (* and quantitative) observations regarding the energy based on all the 
following information: 

� the definition of the average power applied to the MOSFET’s power (drain) circuit (see 
Ref. D and Manual 0, Refs. C and G): 

� your observations concerning the peak instantaneous power PD(on)pk (step 4, in this case 
the peak value can be treated as a characteristic parameter that reflects the properties of 
the entire waveform), 

� your earlier observations regarding time-related parameters (step 1). 

6. Based on observations made above, state whether it is more profitable to use fast or slow power 
semiconductor devices (with short or long switching times) as far as dynamic power loss is 
concerned (see Ref. D and Manual 0, Ref. G). 

7. * For a chosen case check how much estimates based on simplified design formulae (Manual 0, 
Ref. G) are consistent with experiment results. What kind of design error would be made in this 
case if estimated values were used: 

� transistor oversizing increasing its cost and size? 

� or underestimation of power loss and the consequent risk of transistor overheating? 
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E 

Information 

7. Expected Report Contents 

General analysis of switching waveforms 

1. Oscilloscope image of voltages and current for full driving voltage pulse, labelled 
with the current/voltage conversion ratio value of the current probe amplifier, with 
4 transistor switch operating states, according to step 6.1/1 
(i.e., the waveform set {uGS; uDS; iD}) 

2. * Duplicated oscilloscope image of voltages and current for full pulse, with essential 
features of a semiconductor switch marked, according to step 6.1/2 

3. Oscilloscope images of voltages and current with time scale zoomed in, with 
MOSFET regions of operation marked, according to step 6.1/3 
(i.e., the waveform set {uGS; uDS; iD; pD} only showing the turn-on state and an 
analogical one only showing the turn-off state) 

4. * Oscilloscope image of voltages obtained with UDS = 0 and an analysis of turn-on 
waveforms with respect to parasitic capacitances and Miller effect, according to 
steps 6.1/4–5 

Static parameters 

5. Measured values of the drain-source resistance for two static states, estimated 
leakage current (with calculation) and a comparison of values obtained to datasheet 
parameters (* and the one obtained based on oscilloscope measurement), according 
to steps 6.2/1–3 (* and 4) 

6. Measured value of the gate-source threshold voltage and its comparison to the data 
sheet one (* and the one obtained based on oscilloscope measurement), according to 
step 6.2/5 (* and 6) 

7. Comparison of transistor resistance to receiver resistance and conclusions regarding 
transistor’s influence on the circuit in either static operating state, according to step 
6.2/7 
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8. Oscilloscope image of voltages and current for full driving voltage pulse, with 
characteristic levels marked, according to step 6.2/8 

9. Numerical values of the characteristic levels with their justification, according to 
step 6.2/9, 
and threshold values calculated based on them, used to determine time parameters 

10. Static power loss analysis, with calculations and results, according to step 6.2/10 

Dynamic parameters 

11. All the oscilloscope images that have been used to determine the transistor’s time-
related and energy-related parameters for different RG, labelled with RG values and 
current probe conversion ratios, set with plot checks immediately beside or below 
each of them 
(i.e., waveform sets {uGS; uDS; iD; pD} for two RG values, separate for turn-on and turn-
off, and plot checks obtained with Scilab during dissipated energy calculations) 

12. Table or two tables (separate for turn-on and turn-off) containing all the numerical 
results obtained, according to steps 5.3/1–3 
(i.e., results obtained within Section 5.2, two RG values, turn-on and turn-off, time- 
and energy-related parameters) 

13. Analysis of gate resistance influence on time-related parameters with an explanation 
of observations, according to steps 6.3/1–2 

14. Comparison of measured values to datasheet parameters, with supposed causes of 
discrepancies, according to step 6.3/3 

15. Analysis of gate resistance influence on energy-related parameters with an 
explanation of observations, according to steps 6.3/4–5 

16. Conclusion concerning desirable time parameters of power semiconductor devices, 
according to step 6.3/6 

17. * Comparison of values estimated with simplified design formulae to measured ones, 
with calculations and an analysis of practical consequences of discrepancies, 
according to step 6.3/7 

8. Required Knowledge 

8.1. Prerequisites 

� Voltage and current waveforms during VDMOS switching with resistive load 
(see Ref. C considering the purely resistive load case) 

� MOSFET time parameters: physical definitions (based on ideal waveforms), practical 
definitions (based on simplified straight-line waveforms and percentage thresholds) 
(see Ref. C) 

� Energy loss waveforms as a function of instantaneous power 
(see Ref. D and Manual 0, Ref. G) 

Note: For resistive switching ideal waveforms, which are only described not shown in Ref. C, 
you may see the Polish manual, Fig. 3, disregarding any Polish labels. 
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8.2. Test scope 

1. Semiconductor switch. Static and dynamic (switching) operating states. Ideal and 
real (practical) switch and their principal characteristics. Which quantity—voltage or 
current—is considered as the cause (applied to the switch) and which one is 
considered as the (undesired) effect in either static state? 
(see Manual 0, Ref. G) 

2. Field-effect control: channel formation (without formulae or physical details), static 
(voltage-related) and dynamic (capacitance-related) conditions for turn-on. 
(see Refs. A and B) 

3. VDMOS parasitic capacitances: location in the equivalent schematic, location within 
the semiconductor structure, physical interpretation (without formulae), dependence 
on the UDS voltage (plot). 
(see Ref. B and Manual 0, Ref. H) 

4. Voltage and current waveforms during VDMOS switching with resistive load. 
Operating states and regions of operation within waveforms. Effect of parasitic 
capacitances: the RC model of transistor’s control circuit, input capacitance, Miller 
capacitance (formulae). Effect of gate resistance. 
(see Ref. C considering the purely resistive load case, report; for resistive switching 
ideal waveforms, which are only described not shown in Ref. C, see Fig. 6 in this 
manual) 

5. MOSFET time parameters: physical definitions (based on ideal waveforms), practical 
definitions (based on simplified straight-line waveforms and percentage thresholds), 
location within voltage waveforms. Effect of gate resistance and its explanation 
based on the capacitive model of MOSFET’s control circuit. 
(see. Ref. C) 

6. MOSFET energy parameters; instantaneous power waveform during switching 
(synchronised with voltage and current waveforms); relationship between energy 
and power (general integral-based with integration intervals considered); 
explanation of the effect of time parameters. 
(see Ref. D, Manual 0, Ref. G, report) 

When results included in your report are concerned, restrict to the qualitative aspect (character 
of relationships) disregarding the quantitative one (specific values of parameters). 
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